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1.0 Stormwater Design Part 2- Introduction
The Stormwater Design Course Part 1 and this manual, the Stormwater Design Part , describe 
the functions and processes of the 12d drainage module. In these documents, the generic term pit 
refers manholes inlets, catch basin and manholes.

The Stormwater Design Course - Part 1 Notes contain:

s create a super tin for pipe cover and pit cover levels,

s set drainage defaults and layout a drainage network from CAD and in 12d,

s use the 12d drainage network editor to assign names to the pit/pipes, avoid service 
clashes, grade pipes, align obverts, minimise depth and many other design tools,

s designate catchment areas and produce catchment plans,

s run the 12d storm rational hydrology and hydraulics engine,

s transfer data to and from electronic spreadsheets to enable the user to easily review the 
data and add user defined data to the 12d pipe network. This data may include such data 
as pipe bedding types and trench width,

s create a drainage template containing customised default design parameters,

s create pit setout schedules to export to spreadsheets or word processors for final format-
ting,

s produce long section drainage profiles including HGL data, flows, invert levels and serv-
ice crossings,

s create plan drawings with pipe sizes, flows, pit symbols, linestyles for pipe sizes, design 
parameters for pit and pipes and user defined data,

s locate pits/manholes at exact chainage and offset locations.

This manual, the Stormwater Design Course - Part 2, is intended to describe the additional features 
of 12d model drainage and discuss the customisation of the package. This will include

s customising the drainage.4d file,

s 12d storm analysis with inlet capacity calculations and bypass flow,

s flooded width analysis and flooding at SAG pits,

s drainage trench excavation volume calculations,

s pipe and pit quantity calculations/reports,

s open channel calculations,

s adjusting pit locations for changes in horiz road geometry

s analysing the major flood events,

s design or evaluate the drainage system using by creating input files for the xpswmm/
xprat-hgl, Windes, Drains and PCdrain drainage design packages,

s read the output from the drainage design packages and update the drainage network plus 
storing the hydraulic data, such as hgl (hydraulic grade line) levels, peak pipe flows and 
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pipe capacities,

s creating drainage symbols with grates and upstream side inlets,

s detailed drainage plan labelling and long sections with hatching under roads.

2.0 Starting with a Basic Drainage Network
In this document, the generic term pit refers to manholes, inlets, catch basin and manholes. When 
the term manhole is used on the 12d menu system it refers to any type of pit. Pit types, dimen-
sions and inlet capacities of the pits are set in the drainage.4d file.

These course notes assume that you have completed the Stormwater Design Course and that you 
have experience creating 12d model drainage networks with catchments areas. You may continue 
this project or begin with a completed drainage design found in the directory

\12d\9.00\Courses\Drainage_Analysis

The project name is Local Road Complete.

3.0 Setup Filesnd Their Locations
The drainage module consists of the optional 12d Drainage Analysis, utilities, startup configura-
tion files for RAT2000, XP SWMM and the 12d drainage configuration file (drainage.4d).

All setup files have been configured for the training version. However, when you start working on 
real projects you may want customise the drainage module. More - Customising the drainage 
module

The drainage.4d file contains pipe types (RCP, Class 2 etc.) and example pit inlet capacites for 
inlet pits. Detailed pit type descriptions and internal pit dimensions can be included in this file to 
be inserted into your pit schedules. For PCdrain and Drains users there are routines to read your 
gully pit/database files and create the drainage.4d file More.

REVIEW THIS DATA CAREFULLY! The drainage.4d file may be customised for any addi-
tional inlet capacity data you may have.

To edit the drainage.4d file, from the main menu select

Design->Drainage-Sewer->More->Edit drainage.4d

Select the Find button to search the 12d path for the 
current drainage.4d file. If the file is found in the set-
ups folder, it should be copied to the user folder or your 
current working folder before editting it (see below).

Select the More info button (the folder) and then Open 
to edit the file.
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Copying the drainage.4d files
If the drainage.4d file is found in the 12d setups folder or if other drainage.4d files are to be used 
they can be copied from setups folder.

1. Select the More info button (the folder)

2. select lib to open the windows browse 
panel.

3. Select the up level icon.

4. Select the Set_ups folder. Now we are 
ready to copy the desired drainage.4d 
file.
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5. type dr*.4d and press Enter to get a list of the drainage.4d files.

6. RB the desired file

7. Select Copy to place the file on the clipboard.

8. select the Up level icon to move back up a level

9. Select the User folder

10.RB in the white space and then selectPaste.

11.The file can now be renamed drainage.4d if it had another name.
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You must restart 12d for these changes to become active. Select Project->Restart!

At startup, if there are significant errors in the file, refer to the output window where 12d will print 
the line number where it give up. When looking in the long list of files, the drainage.4d file is loaded 
after the shp files.

See “The drainage.4d file” on page 19.

REVIEW THIS DATA CAREFULLY! A detailed description of the pit inlet capacity tables in this 
file is given in “Pit Inlet Capacities” on page 26. The drainage.4d file may be customised for any 
additional inlet capacity data you may have.
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4.0 Bypass Flow
Bypass flow strings are used to trigger the bypass calculations in the network editor and are used 
as a centre line for flooded width calculations.

The 12d storm analysis, and many of the design programs 12d exports to, allow for bypass flow. 
Bypass flow involves the calculation of pit inlet capacity for on-grade or sag pits. These capaci-
ties are based on the pit type and may use either ponding depths (sag pits) or on the road grade 
and/or crossfall upstream of the inlet.

Key Points
1. Draw an bypass flow string in the direction of flow so that it passes within 1 pit diameter of an 

inlet. At sag locations the string should show the direction of flow during bypass conditions. 
When bypass flow strings join they must join within 1 pit diameter of an inlet (pits with inlet 
config set to Manhole are not considered inlets). If flooded with calculations are to calculated 
the string should located in the flow channel.
Enter the model name in the Bypass flow model field on the Global->Utility Models tab.

Note: if there is no bypass flow string within 1 pit diameter then 100% of the approach flow 
will enter into the pit.

2. Many bypass strings may join at an inlet but only one bypass string should leave each inlet.

3. Set the pit type. (Pit Type on the Pit tab). With a bypass string within 1 pit diameter of the pit 
centre, no water will enter the pit unless the pit type has inlet capacity data defined in the drain-
age.4d file. 

4. Set the Inlet config on the Pit->Main tab (Manhole, On-grade or Sag pit). This selection will 
be disabled if cap_config parameter sets the inlet type in the drainage.4d file. Manholes have 
no inlet capacity and are not considered inlets, on-grade inlets capture the water as it passes the 
inlet while SAG inlets trap the water flowing in from all directions (until the pond depth over-
flows at the low point of the catchment string).

5. On grade pits may require road grade and/or crossfall data for inlet capacity. They may be 
entered manually or calculated using the road strings. A setout string link is required to meas-
ure road grade. If road crossfall measurement is needed then the centre string is also required. 
These strings are specified using the Road design file on the Global->Utility Models tab (see 
Stormwater Part 1 manual).

6. Sag inlets require a pond depth either manually entered or calculated by 12d. Pond depth cal-
culations require a link to a catchment string to locate the overflow point and correct grate 
level (Grate rl mode).

7. Press the Set Pit Details button. Road grades, crossfalls, pond depths and bypass pits will now 
be found on the Pit->Bypass tab of the Network Editor. Measurement markers are created in 
the construction drainage data model.

8. Bypass pits may be cleared using Clear Bypass Links on the Globals->Utility Models tab

9. Storm Analysis must have Consider Bypass Flows selected on the Main tab.

10.Calculate overland flood extents is optional on the Flood Extents tab of Storm Analysis.
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4.1 Drawing Bypass Flow Strings
The bypass flow string must be within 1. pit diameter of the drainage pit in be considered on the 
bypass flow path. If the bypass flow string is to be used for flooded width calculations in the future, 
the string must also be drawn in the main flow area of the cross section. At sag locations the bypass 
flow strings indicate the direction the water flows when it overtops the overflow point. This string 
usually goes uphill to this overflow point.

For a project with roads it is easiest to copy a road string (invert strings are usually the best) into the 
flow model and then check the string to see if it flows down hill. You may be required reverse the 
direction of some strings, split some strings at major crests, join some strings that do not meet at 
inlets and finally add some flow lines where flow crosses the road.

Copying the Invert strings into the bypass model
First we will create a new view for just the road strings.

View->Create->Plan view

11.Type Roads

12.Select Create
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From the main menu select

1. Place your point over the + button and press 
Shift+r to display all of the models starting with 
R.

2. Drag your pointer across all of the road models to 
select them

3. Lb the Select button to add them to the view.

Utilities->A-G->Change

1. Select the filter button

2. Select the View button and then 
select the Roads view

3. Select the String Info tab.
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Splitting the Strings at Major Crests
If the roads contain a major crest that defines a separate catchment then the flow lines will need to be 
split so that one segment can be reversed.

If you have labelled the crests and sag points then you can use these labels to quickly identify the 
crests.

1. Type *inv to select the rinv and 
linv strings.

2. Select Filter Select to select the 
*inv strings from the Roads 
view.

3. Note that 17 strings have been 
selected from the roads models.

4. Enter a New name so that the 
string will not be confused with 
the road invert strings in the 
future.

5. Either type FLOW LINE or 
select the line style button, then 
select the group Drainage 12d 
and finally FLOW LINE line-
style.

6. type bypass flow,1 for the new 
model. The ,1 will add the 
model to view 1 for you.

7. select Change to copy the 
strings to the new model with 
the new line style.
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1. Drag out the CAD string toolbar and select the String split icon.

2. Instructions will be given in the 12d message area (bottom left corner of the screen). Pick 
and accept the string to be split.

3. Pick and accept the split point or if you have them the crest marker. The string will now be 
split.
repeat steps 2 and 3 for all strings to be split. Press ESC when finished.
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Reversing the Strings if they flow in the wrong direction

Joining Flow Lines Together
If the flow lines join each other within 1 pit diameter of an inlet (not a manhole) then they do not 
need to be joined (but they can if desired). If there is no inlet at the join then you will have to join the 
strings together.

1. Drag out the CAD string toolbar and select the String Reverse icon.

2. Instructions will be given in the 12d message area (bottom left corner of the screen). Pick 
and accept the string to reverse.

continue selecting strings to be reversed. Press ESC when finished.
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Adding additional flow lines where the flow cross the road
Use the CAD toolbar to create the bypass flow paths.

Starting at the upstream end. LB select an insertion point and MB or press return to accept the 
selection. Continue this until you reach the end of the flow path. The string will not be shown in 
the new linestyle until the screen is redrawn. Press ESC to finish drawing the string. MB on the 
plan view title area to redraw the screen. The correct linestyle will now appear. 

1. Drag out the CAD string 
toolbar and select the String Join icon.

2. Instructions will be given in the 12d message area (bottom left corner of the screen). Pick 
and accept the upstream string then pick and accept the downstream string. Since they are 
already drawn in the same direction you will not have to use a directional pick.

continue selecting strings to be joined. Press ESC when finished.

To use the CAD toolbar go to the CAD data bar and enter a 
string name and model name. Select the line style (optional).

DRAG the Create line button and release at 
the Create Line String button.

When finished drawing the string press ESC.
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If you reach a sag pit location you may terminate the string or continue defining the bypass flow path 
for a surcharging event out of the sag location.

4.2 Set Pit Details - Calculate the Bypass Flow Data
Once the first Key points of bypass flow (listed above) are complete, you are ready to calculate the 
bypass flow data. Select Set Pit Details and then select a pit on a bypass flow string. The bypass data 
is found on the Pit->Bypass and Pit Main tabs. 

12d supports Manhole, on-grade and SAG configurations. The inlet configuration is set on the Pit-
>Main. This settings can be locked to the Pit type in the drainage.4d file using the cap_config com-
mand (discussed later but shown above). Pits with Inlet config set to Manholes will not receive 
bypass flow and cannot have catchments assigned to them. On-grade pits are pit where the water will 
flow passed the pit if not captured and Sag pits are located at sag locations where the water will pond 
around the pit if there is not enough inlet capacity.

The remaining bypass data is found on the Pit->Bypass tab.
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The downstream pit will now show in the Bypass pit field. If the bypass string does not go to 
another inlet (the network outlet is never an inlet) then the Bypass pit will be marked as LOST.

If Pit on grade is selected and a setout string was found (see Pit->Setout tab), the Road grade 
will appear in grey. You may override this value by selecting the Manual tick box beside the 
value and entering your own value. If a road centre string was selected, the Road xfall field will 
also have a value.

If Sag pit was selected and a catchment string was selected, the Max pond depth will be dis-
played. The catchment strings from all 3 sets are draped onto the finish surface tin and the low 
point located. The Max pond depth is calculated as 

Max pond depth = catchment string low point - Grate RL.
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Negative Pond Depths

Negative pond depths are usually caused by one of two errors in input. The first may be that the grate 
level is too high. Often this happens when the Grate RL mode on the Pit->Main tab has not be set 
correctly or if Sz + setout string option is used the Sz value on the Pit->Setout tab has been entered 
correctly.

The second common error is that the catchment string has not been drawn around the crest of the 
catchment. The lowest section of the catchment string must be drawn carefully because it is the low-
est point on the string that determines the overflow elevation. If in doubt, profile the catchment string 
with the design tin shown in the section view. Double check were the low point is. The location of 
the low point is also shown as a green vertex (plus sign) in construction drainage data model.

Verification strings in the same model confirm the locations where the road grade and crossfall have 
been measured. To check these strings add the construction drainage data model to the plan view. 
The following image shows a close up of the verification strings at a pit.
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The default location of the road grade measurement is one pit diameter upstream of the setout 
point, along the setout string. The road crossfall is measure one pit diameter away from the setout 
point towards the road centreline. These are 3d super strings and therefore you may profile them 
in the section view. With the grades toggled on (check under Toggle) you can verify the slopes.

The location of the road grade and crossfall measurements can be changed in the road design file. 
The distance upstream to measure the road grade is controlled by the Grade offset column one 
the rows where the setout strings are defined. The road crossfall is controlled by the Xfall offset 
column on the rows where the road centre lines are defined. The distance the measurements are 
taken is controlled by the Slope measurement distance.

The green line indi-
cates where road 
grade was meas-
ured and the 
magenta line indi-
cates where the road 
cross fall was meas-
ured.
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Important Notes

1. Pits with a bypass pit entered but no inlet capacity defined in the drainge.4d file will have a zero 
inlet capacity.

2. With Inlet config set to Manhole, the pit has no inlet capacity.

3. If no bypass flow string is supplied for a pit, the inlet capacity is set to 100%.

4. If you have a problem with the inlet capacity calculations, check the Storm Analysis hydrology 
report for details.
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5.0 The drainage.4d file
The drainage.4d file controls many of the settings for the pit and pipes types inside 12d. This sec-
tion details the format of the drainage.4d file. Changes to this model take effect only after 
12dmodel has been restarted. If there are any errors in the drainage.4d file they will be listed in 
the output window at startup (just after the shp file listing). The error in the drainage.4d file is 
generally located just above the line indicated in the output window.

All text to the right of the // is ignored by 12d (comments). There are pit and pipe type definitions. 
Because of historic reasons the pit types are defined using a Manhole command. 

Many of the settings in the drainage network editor (DNE) can be controlled by the pit types and 
the pipe types defined in the drainage.4d file. The special manhole attributes defined below con-
trol these fields.

The original drainage.4d file is found in the “program files\12d\12dmodel\9.00\set_ups” direc-
tory. Do NOT change this file. Copy it into your user folder “\12d\9.00\User” and edit it there. 
Files in the user directory are used by preference and they are never over written by a 12d update.

5.1 Pit Type definitions
The order of the pit type definitions controls the order of the pit types in the DNE drop down list. 
The minimum requirement for a pit type definition is
Mnahole “name” {
}

The name must be unique and the braces {} cannot be () or []. 
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Example:

The setout xy mode controls the following on the DNE.
attribute_integer "setout xy mode" 0 //[0,1,2] Pit=>Setout=>Setout xy mode

The 0,1,2 are the values to be used. The order of the numbers [0,1,2] is the same as the order in the 
DNE drop down list. The numbers are not always in sequential order.

0 Pit centre
1 Setout string
2 Manual

The following example of a channel ip point is given below. The setout modes are set, the cover and 
grate level modes are set and the ku (losses) are set. Finally, the inlet capacity is set to an on-grade pit 
with200% inlet capacity so that even in a major storm with a choke factor of 0.5 it will still have 
100% inlet capacity.
Manhole "CHNL auto" {

  mhdesc  "channel hip-vip"
  attribute_text "lplot description1"  "OPEN CHANNEL"

  mhsize  0.0
  mhdiam  0.0
  attribute_integer "setout xy mode" 0 // centre of the channel
  attribute_integer "setout z mode" 6 // sump invert is the bottom of the chan-
nel
  attribute_integer "cover rl mode" 4 // max obvert - top of the channel
  attribute_integer "grate rl mode" 4 // max obvert - top of the channel
  attribute_integer "ku method" 0    // direct
  attribute_real    "ku" 0.0  // zero unless interested in bend 
losses
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  cap_config G

  cap_percent 200 // if a choke factor of 0.5 is applied then it will still 
have 100% inlet capacity
}

Manhole Commands

//
======================================================================================
// Rules for manhole/pipe attributes in the drainage.4d file:
//
======================================================================================
//  From V9, bothpit the Manhole and Pipe entries support attribute entries based on 
manhole/pipe type:
//
//  attribute_integer "attribute name1" <Integer value>
//  attribute_real    "attribute name2" <Real value>
//  attribute_text    "attribute name3" "Text value"
//
//  The following manhole & pipe attribute names are recognised as special by 12d, and 
may be used to take
//  control of the matching fields in the Drainage Network Editor for the applicable 
manhole/pipe types:
//
//  ----------------------------------------------------------------------------------
//  Special manhole attributes               Valid values          DNE field
//  ----------------------------------------------------------------------------------
//  attribute_integer "cover rl mode"        [0,3,1,8,4,2] Pit=>Main=>Cover RL mode
//  attribute_integer "grate rl mode"        [7,0,3,1,8,4,2] Pit=>Main=>Grate RL mode
//  attribute_real    "sump offset"                                Pit=>Main=>Sump offset
//  attribute_integer "ku method"            [0-3,101-110,201-223] Pit=>Main=>Ku method
//  attribute_real    "ku"                                         Pit=>Main=>Ku
//  attribute_real    "kw"                                         Pit=>Main=>Kw
//  attribute_integer "setout xy mode"       [0,1,2] Pit=>Setout=>Setout xy mode
//  attribute_integer "setout z mode"        [7,0,3,1,8,4,5,6,2]

Pit=>Setout=>Setout z mode
//  attribute_integer "road chainage mode"   [0,1,2] Pit=>Setout=>Chainage mode
//  attribute_real    "setout adjustment"                          Pit=>Setout=>Sxy
//  attribute_real    "setout adjustment z"                        Pit=>Setout=>Sz
//  attribute_real    "design freeboard" Pipe=>Design=>Freeboard limit at US pit

//  Any other manhole/pipe attribute name may be specified, apart from those documented 
in:
//  http://www.forums.12dmodel.com/downloads/Owen.Thornton/12d_Drainage_Attributes.pdf
//  which are reserved for use by the 12d 'Drainage' and/or 'Drainage Analysis' modules.
//
//  NB1: If a non-special attribute name is set for some, but not all Manhole types, 
then that attribute
//         will be deleted on all manholes with types where the attribute is not set.
//  NB2: If a non-special attribute name is set for some, but not all Pipe types, then 
that attribute
//         will be deleted on all pipes with types where the attribute is not set.
//
======================================================================================
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==

//=============================================================================
// Manhole Format:
//=============================================================================
//Manhole "manhole type" {
//
//  //All entries inside a Manhole entry are optional.
//
//  attribute_integer "attribute name1" <Integer value>
//  attribute_real    "attribute name2" <Real value>
//  attribute_text    "attribute name3" "Text value"
//
//  mhsize  <x.x> [<x.x>]  //Nominal Length [and optional Width] in <base units>
//  mhdiam  <x.x>          //controls drawn MH diam on Drainage string (omit mhdiam entry 
to specify independent of manhole type)
//
//  mhdesc  "verbose description of the manhole type"
//  mhnotes "extra remarks about this manhole type"
//  mhgroup "manhole group to which the type belongs"
//
//  //Capacity configurations (omit cap_config entry to specify independent of manhole 
type):
//  //  "cap_config G" = on-grade pit ... OR
//  //  "cap_config S" = sag pit      ... OR
//  //  "cap_config M" = manhole (sealed pit)
//
//  cap_config G
//
//  //Inlet capacity data for G and S configs (generic):
//
//  cap_multi   <x.x>
//  cap_fixed   <x.x>
//  cap_percent <x.x>
//  cap_coeff   <x.x>
//  cap_power   <x.x>
//
//  //Inlet capacity data for G config (by road grade & xfall):
//
//  cap_curve_grade "curve 1" {
//    road_grade  <x.x>
//    road_xfall  <x.x>
//    cap_multi   <x.x>
//    cap_fixed   <x.x>
//    cap_percent <x.x>
//    cap_coeff   <x.x>
//    cap_power   <x.x>
//    coord <Qa> <Qin>
//    coord <Qa> <Qin>
//    coord <Qa> <Qin>
//  }
//  cap_curve_grade "curve 2" {
//    road_grade  <x.x>
//    road_xfall  <x.x>
//    cap_multi   <x.x>
//    cap_fixed   <x.x>
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//    cap_percent <x.x>
//    cap_coeff   <x.x>
//    cap_power   <x.x>
//    coord <Qa> <Qin>
//    coord <Qa> <Qin>
//    coord <Qa> <Qin>
//  }
//  cap_curve_grade "curve n" {
//    road_grade  <x.x>
//    road_xfall  <x.x>
//    cap_multi   <x.x>
//    cap_fixed   <x.x>
//    cap_percent <x.x>
//    cap_coeff   <x.x>
//    cap_power   <x.x>
//    coord <Qa> <Qin>
//    coord <Qa> <Qin>
//    coord <Qa> <Qin>
//  }
//
//  //Inlet capacity data for S config:
//
//  cap_curve_sag "curve sag" {
//    cap_multi   <x.x>
//    cap_fixed   <x.x>
//    cap_percent <x.x>
//    cap_coeff   <x.x>
//    cap_power   <x.x>
//    coord <Depth> <Qin>
//    coord <Depth> <Qin>
//    coord <Depth> <Qin>
//  }
//}
//-----------------------------------------------------------------------------
// Rules for Pit Inlet Capacity Data
//-----------------------------------------------------------------------------
//
//Qa  = pit approach flow rate
//Qin = pit inflow rate
//Qb  = bypass flow rate = Qa - Qin
//
//If pit is sealed (i.e. a manhole)   : Qin = 0
//If no bypass pit (i.e. 100% capture): Qin = Qa
//
//Else: Qa >= Qin = choke*cap_multi*(  cap_fixed
//                                   + cap_percent*0.01*Qa
//                                   + cap_coeff*Qa^cap_power
//                                   + cap_curve_? {
//                                       cap_multi*(  cap_fixed
//                                                  + cap_percent*0.01*Qa
//                                                  + cap_coeff*Qa^cap_power
//                                                  + [Qin via coord lookup] )
//                                     }
//                                  )
//
//                  where: 'cap_curve_?' is the applicable curve data
//
//Default values for unspecified entries:
//  cap_multi   = 1.0
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//  cap_fixed   = 0.0
//  cap_percent = 0.0
//  cap_coeff   = 0.0
//  cap_power   = 1.0
//
//Rules for 'cap_curve_grade' entries:
//  *Only applicable to on-grade pits.
//  *All cap_curve_grade entries must be uniquely named within a pit.
//  *The 'road_grade' and 'road_xfall' entries are both optional, but their
//     use must be consistent across all cap_curve_grade entries within a pit.
//  *If both 'road_grade' and 'road_xfall' entries are omitted, only one
//     cap_curve_grade entry is allowed within a pit.
//  *The 'road_grade' and 'road_xfall' entries must be specified in %, and are
//     interpreted as minimum threshold values.
//  *The cap_curve_grade 'coord' entries (if used) must be in order of
//     increasing Qa.
//
//Rules for 'cap_curve_sag' entries:
//  *Only applicable to sag pits.
//  *Only one cap_curve_sag entry is allowed within a pit, and it must have
//     a valid name.
//  *The cap_curve_sag 'coord' entries (if used) must be in order of
//     increasing Depth.
//  *It is recommended that all sag pits have 'coord' entries, because even
//     if there is no bypass pit (100% capture), the 'coord' entries are used
//     to reverse-calculate the flooded depth at the sag inlet, based on Qin.
//
//NB1: Flow rates must be specified in "cubic <base units> per second".
//NB2: Depths must be specified in <base units>.
//NB3: For choke factors: 0.0 means blocked, 1.0 means unblocked.
//
//=============================================================================
======================================================================

5.2 Pipe Type Definitions
The order of the pipe type definitions controls the order of the pipe types in the DNE drop down list. 
The minimum requirement for a pipe type definition is
Pipe “name” {
}

The name must be unique and the braces {} cannot be () or []. 



Revised October 2010 12d Stormwater Course - Part 2 Notes: Page 25 of 88

12d Solutions Pty Ltd

COURSE NOTES

STORMWATER DESIGN - Part 2
Example:

The roughness type and value types can be set in the DNE.
roughness_n 0.040

Example:
Pipe "CHNL GRASS PROPOSED" {  //Open Channel created below the tin. cover set 
in cover file to 0.0
  roughness_n 0.040
  attribute_integer "design size mode"     3  // open channel mode
}
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Pipe Commands
//=============================================================================
// Pipe Format:
//=============================================================================
//Pipe "pipe type" {
//
//  //All entries inside a Pipe entry are optional.
//
//  attribute_integer "pipe attribute name1" <Integer value>
//  attribute_real    "pipe attribute name2" <Real value>
//  attribute_text    "pipe attribute name3" "Text value"
//
//  //Pipe roughness ... n or k (omit roughness entry to specify independent of 
pipe type):
//
//  roughness_n <Manning n roughness value>
//  roughness_k <Colebrook k roughness value> //in millimetres
//  ----------------------------------------------------------------------------------
//  Special pipe attributes                  Valid values          DNE field
//  ----------------------------------------------------------------------------------
//  attribute_real    "min height"           [> 0.0]               Pipe=>Design=>Min pipe 
height
//  attribute_integer "design size mode"     [0,1,2,3]             Pipe=>Design=>Design 
mode
//  attribute_real    "design percent depth" [> 0.0]               Pipe=>Design=>Flow-depth 
at pipe entrance
//  ----------------------------------------------------------------------------------
//

//}
//=============================================================================

5.3 Pit Inlet Capacities
The pit inlet capacity tables contained within the drainage.4d file are used by the drainage design 
packages in different ways but with a common philosophy.

5.3.1 On grade pits
The grade and crossfall values for the tables are threshold values, i.e. the next set of capacity factors 
will not be used until the crossfall and grade are equal to or exceed the values for the curves. The 
curves are not interpolated!

12d Storm Analysis

Some sample Pit definitions follow to demonstrate how the pit inlet capacities are calculated.

Manhole "SEP 25" {

  mhsize  1.200 0.900
  mhdesc  "SEP with 25 l/s"
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  mhnotes ""
  mhgroup "SA"

  cap_multi   1.0
  cap_fixed   0.025

}

Manhole "SEP 50 percent" {

  mhsize  1.200 0.900
  mhdesc  "SEP with 50%"
  mhnotes ""
  mhgroup "SA"

  cap_multi   1.0
  cap_percent 50.

}

Manhole "SEP Grade x 10" {

  mhsize  1.200 0.900
  mhdesc  "SEP with 25 l/s"
  mhnotes ""
  mhgroup "SA"

  cap_curve_grade "curve 1" {
    road_grade  1
    cap_multi   1.0
    cap_fixed   0.010
  }

  cap_curve_grade "curve 2" {
    road_grade  2
    cap_multi   1.0
    cap_fixed   0.020
  }

  cap_curve_grade "curve 3" {
    road_grade  3
    cap_multi   1.0
    cap_fixed   0.030
  }

  cap_curve_sag "curve sag" {
    cap_multi   1.0
    coord 0.0  0.000
    coord 0.1  0.010
  }
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}

Drains Version 1 and ILSAX

The cap1, cap2, cap3 and cap4 values are used to describe the inlet capacity of the pit as described in 
their user manuals.

Drains Version +

The 12d inlet curve names are exported to Drains as the pit family.

xpswmm, xpstorm and RAT-HGL

If cap2, cap3 and cap4 are all equal to zero then a fixed inlet capacity equal to cap1 will be exported 
to RAT-HGL. If the sum of these three values is greater than zero then a pit type will be created in the 
format of pit_type-crossfall-roadgrade. For example SA2-3-2 for a SA2 pit with a road crossfall of 
3% and a road grade of 2%. A rating curve with this name will have to exist inside RAT-HGL. 12d 
has no way of transferring the rating curve itself into RAT-HGL.

PC Drain

Similar to RAT-HGL, PC Drain has it own rating curves defined internally. The road grade is sent as 
a separate piece of data to PC Drain so that the pit inlet capacity may be determined.

5.3.2 SAG Inlets
PC Drain

PC Drain places a suffix code in the pit type to specify that the pit is a SAG pit. For example an 
9S.03 indicates that pit type 9 is a sag pit and the maximum depth before bypassing is 30mm.
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6.0 12d Storm Analysis Bypass and Flooded Width Calculations
Once the bypass pits are selected and the drainage.4d file has been setup for bypass flow the 
storm analysis engine must have this feature enabled. Select Consider bypass flow. 

Excess Flow
The Qx value controls how excess flow is handled in the bypass flow calculations. If the hgl at the 
pit reaches the grate level then no more water can enter the pit even if there is inlet capacity. The 
flow that will not enter the pit is considered excess flow. When a value greater than zero is entered 
here, the inlet will initially have its inlet capacity restricted by this value. Upstream inlets are done 
first as this may reduce the hgl in the downstream system. The system is automatically rerun 
adjusting the flows by this amount each time.

If the inlet capacity is reduced to zero and the hgl is still above the pit then water is removed from 
the pit and considered as Qs (surcharge flow). In the hydraulic reports this value is found as a neg-
ative Inlet Flow Qi.

Overland Flow Calculations
The storm analysis engine will calculated flooded widths from normal depths along the flow path 
and ponding extents at SAG inlets. A bypass flow model (Global-Utility Models tab) is required 
for these calculations.

The Utility String Editor should be used where bypass flow strings combine at a pit. Without 
using this editor it is assumed that 100% of the catchment flow flows down each bypass flow 
string thereby overestimating the flooded widths.

The Utility String Editor could be used to change the Manning’s along the string (approach 
channels to culvert for example) or the maximum flooded width warning limit (before a pedes-
trian crossing or a highway off-ramp). 

The models and the default input data for these calculations are entered on the Flood Extents tab.
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Select Calculate overland flooded extents to active the fields on the panel.

Model for sag ponds is used to hold strings that indicate the extent of flooding at the pits marked as 
SAG inlets. The total approach flow is used with the cap_curve_sag in the drainage.4d file to deter-
mine the depth of flooding above the grate level. A closed contour at this flood elevation is then 
selected near the centre of the inlet. A super string is then created at this level with the colour and fill 
blend transparency selected (1.0 is solid).

Model for flooded width holds the strings indicating the normal depth - flooded width calculation 
results. These strings are created with a fixed elevation of the flood level. The strings will have string 
attributes with all of the calculations details.
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Calculations

1. Cross sections are cut perpendicular to the overland flow string at the interval X-section sepa-
ration with a length of X-section length. No calculations are done for sect of the bypass flow 
string with in Model of exclusion zones polygon.

2. The x-section string is then trimmed using the Trim settings.The section above had a x-section 
length of 20 and was trimmed at the levee. The levees setting has the routine search for levee 
(high points) on either side of the low point near the bypass flow string. The levee points are 
found if sections drops more than the Levee tolerance value after the high point is found.

3. The flow for the section is calculated using the bypass flow string chainage to interpolate 
between the upstream bypass flow and the downstream approach flow. The percentage of 
catchment flow used in the calculation of the approach flow for this bypass string may be 
changed using the Utility String Editor.

4. The slope of the surface near the bypass flow line is measured for each section. If the slope is 
less than Min longitudinal grade (%) then this cross section is skipped in the calculations.

5. Manning n value is the default roughness used in the calculations. This value may be changed 
at any vertex along the bypass flow string using the Utility String Editor.

6. The flow’s calculated at the indicated level are multiplied by the Manning’s Q correction fac-
tor. A factor of 0.8 would cause the flooded widths to increase and the road capacity to 
decrease.

7. The maximum depth calculated will be at the point where water overflows the edges of the sec-
tion (Road capacity) unless Contain overflow within levees is selected. This will cause fric-
tionless vertical walls to be placed at the ends of the section so that higher water level may be 
calculated when the flow is greater that the road capacity.

Warning Models
Model for W warnings will contain copies of the flooded width strings with the colour selected 
if the flooded width is greater than the default Max W value.

Model for D*V warnings will contain copies of the flooded width strings with the colour 
selected if the depth * velocity is greater than the Max D*V value.

Model for Q warnings will contain copies of the flooded width strings with the colour selected if 
the flow is greater than the capacity of the section. The capacity is the flow where the water over 
tops one of the sides of the section.
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7.0 Drainage Utility String Editor
Drainage_utility_string_editor

Position of option on menu: Design =>Drainage-Sewer =>Utility String Editor

The drainage utility editor is used to assign left and right bank roughness to cross section shape 
strings and to change the default values used for flooded width calculations along a bypass string.

First the string is selected at the vertex where the values are to be assigned. Next select the purpose 
of the string (cross section or bypass) to unlock the appropriate fields. A textstyle favourite is 
required as the vertex is labelled with the assigned values. Enter the values into the fields and then 
select Set to set the values as vertex attributes and create the label as a vertex annotation.

On selecting the utility string editor option, the utility string editor panel is displayed.

The fields and buttons used in this panel have the following functions.

Field DescriptionType Defaults Pop-Up

Vertex index vertex selected vertex

Once the string is selected use this to move between vertices

Style for Vertex Labelstextstyle favouritetextstyles

A label is created on the vertex using this textstyle favourite

Left bank Input

mannings n value, to delete clear and select set

Right bank Input

mannings n value, to delete clear and select set
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Max Flooded withInput

This changes the threshold were warning bars are created during flooded width calculations. It 
remains in effect till the next change or the end of the bypass flow string.

Qdc percentage Input

This changes the percentage of the Qdirect+Qcatchment that is used to interpolate the discharges dur-
ing flooded width calculations. It is generally set on the first vertex past upstream pit and remains in 
effect till the next change or the end of the bypass flow string. The flow changes from the bypass flow at 
the upstream pit to this value/100*(Qdirect+Qcatchment).

Manning’s n Input

This changes the Manning’s n value used for during flooded width calculations. It remains in effect till 
the next change or the end of the bypass flow string.

Pick button

Use this button to select the string. Select near the vertex you want assign the values to.

Set button

Creates the attributes and the label on the vertex.

Finish button

Removes the panel from the screen.

Help button

Launches the 12d help
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In the example above, The Qdc is set to 80% at the eastern end of the catchment. The Qdc is set to 
2% for the water overtopping the road. The 18% of the area is not considered large enough to do the 
flooded width calculation for. If desired, another bypass flow string approaching from the east could 
be drawn but the final bypass string to the west (direction during bypass should remain).
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8.0 Open Channel Flow
12d can model flow in open channels a trapezoidal sections. Suggestions for drainage network 
editor settings are listed below.

Generally, simple channels leading into a pipe network are often not modelled as open channels. 
The flooded width calculations can perform flooded width calcs (normal depth however) along 
the channel and the depth at the headwall is calculated using the headwall ku method.

If gradually varied depth/backwater calculations are desired then the channel will need to be mod-
elled as a drainage string. Also if the pipes discharge into a channel then this channel will also 
need to be modelled as a drainage string.

Key points

The pit grate level must always be at or above the top of the open channel conduit.

Changes in vertical grade and horizontal alignment require a pit in the drainage string. The pit 
diameter is usually set to zero.

Channels may exist in the tin or you may be proposing a channel to be cut into the tin. The grad-
ing and grate level modes will be different for each case. These channel type will be referred to as 
“Existing” or “Proposed”

Pit-Main Tab

1. Selecting the CHNL auto pit typechanges many setting in the DNE.
Cover RL mode is changed to Max obvert.
Grate RL mode is changed to Max obvert.
Pit diameter of diameter of zero. This will result in a single line on the drainage long sections 
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instead of a pit. 
Ku method is set to Direct and a Ku of 0 for the channel change of grade points (pits).
Inlet config - On-grade pit - it has a 200% inlet capacity. The 200% inlet capacity is in case a 
choke factor is accidentally applied.

2. Select the Pit Setout tab

Pit-Setout Tab

Setout xy mode is set to Pit centre
Setout z mode is set to Sump Invert which is the lowest of the channel inverts if Sump offset = 
0(Main tab).

3. The Chainage mode may be be changed to No Road if the channel centre line is not to be used 
for setout.If the default was Centre string this will stop the Problem message saying the cen-
treline string is not found.
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Pipe-Main Tab

4. Change to the Pipe->Main tab

5. Change the Pipe type to CHNL GRASS PROPOSED. This changes the following:
the Roughness type to Manning
the roughness for the open channel to 0.040

6. Set the Height, Top width and Bottom width of the channel.

Note: The pipe type can now be changed back to channel if you needed to alter any of the locked 
settings. Selecting the CHNL GRASS PROPOSED first set most of the setting correctly as a 
good starting point.
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Pipe-Design Tab

7. Change to the Pipe->Design tab

8. Set the Align mode to “IL-IL drop” 

9. Set the Align drop value to 0 (unless you are designing drop structures for your channel.

10.Min Grade % for open channels is usually much less than pipes.

Note: The Design mode has been changed to “Open Channel: Freeboard Design”. This will allow 
supercritical flow to continue through the channel junctions. Often the Freeboard limit will be differ-
ent for a channel than the pipe system.
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9.0 Horizontal Change in Road Alignment (Adjust Pit Locations)
It is advised that you have a link in your road template that is used for setting out the centre of the 
drainage pits. This make the job of placing the pits much quicker and if the road alignment moves 
horizontally the pits can be moved back onto these strings (moved perpendicular to the road 
string).

First we will widen the road using the templates. From the main menu select

Design->Template->Create Edit

1. Select the Carriageway template

2. Lb the Fixed button.

1. Change the Width to 4.

2. Lb the OK button.

1. Select the Full road width template

2. Lb the Fixed button.
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Now we can move the pits back onto the lok string. From the main menu select,

1. Change the Width to 4.

2. Lb the OK button.

Utilities->Functions->Recalc->Recalc->design

Design->Drainage-Sewer->More Drainage->Adjust pit locations

1. LB the filter button

2. Lb more info View button and select the 
Roads view that holds all of the road 
strings.

3. LB the String Info tab
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4. type *lok to select both the llok and rlok 
strings.

5. Lb Filter Select button to see how many 
strings are selected.

6. LB the Drainage model more info button 
ans select the drainage model.

7. Leave the default search distance as 1.

8. Lb Run to move the pits.

There is an undo for this operation.
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10.0 Major Flood Events
To keep the results file from the minor event rename the drainage models using

Models->Global Rename

1. Type the Search criteria to select the drainage models

2. Type the Replace criteria. Note the 10 has been added.

3. Scroll down to see the new model names.

4. Lb Rename button

5. Lb the Finish button.



Revised October 2010 12d Stormwater Course - Part 2 Notes: Page 43 of 88

12d Solutions Pty Ltd

COURSE NOTES

STORMWATER DESIGN - Part 2
Next, create a copy of your drainage network and add a suffix to the model name. Select File IO-
>Data Output->12da/4da data.

Now read the same file into 12d using a suffix 10. Select File IO->Data Input->12da/4da data.

1. Select the drainage model

2. Type the name of the 12da file
drainage 10

3. Lb the Write button

4. Lb the Finish button.

1. Select the file written above

2. Type the postfix “* 100”. 

3. Lb the Read button

4. Lb the Finish button.

1. Select the model created above 
drainage 10 100

2. Type the new name drainage 100

3. Lb the Rename button

4. Lb the Finish button.

Lastly, rename the imported file to remove the 10 
from the name.
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For major flood events the user may desire to use an alternative set of values for 

Catchment tc,
Catchment C,
Pit direct inflow (Qdi),
Pipe direct inflow (Qpi),
Pit choke factor for ongrade inlets,
Pit choke factor for SAG inlets,
Outlet tailwater levels.

These controls are found on the Storm Analysis Panel, Main tab.

1. Ensure you have selected the drainage 100 model.

2. Type the new return period.

3. Select the major storm setting.

4. turn off the Modify pipe inverts and Modify pipe sizes.

5. Change the name of your report files by adding 100 after drainage.
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11.0 Excavation Quantities
Sample templates are included in the 12d library (pipe template.tpl). The templates from this tem-
plate library may be added to your project using 

Design=>Templates=>Utilities=>Input.

This routine uses 12d templates to calculate the excavation volume for all of the drainage strings 
in a model. An option to create section for a tin on top of the pipe is also available so that the 
drainage long sections can include hatching between the obvert of the pipe and the design tin 
under roads.

Templates with names set to the pipe diameters (times 1000) are used for the calculations, thus 
trench shapes can be customised and over excavation for bedding materials can be included. Net 
area calculations to exclude pipe area are not supported.

Key points

1. One template for each pipe size (mm) 

2. If obvert templates are used, add the prefix “obvert “ to the pipe size

3. Carefully consider the tin selected.

A template must exist for each pipe size in the model (pipe size x 1000). For example a 0.3m pipe 
will require a template to exist named 300. A 0.5ft pipe would require a template named 500. 
Sample templates are included in the courses section of 12djobs (\12djobs\courses\7.00\drainage). 
These may be copied to your *.project directory and then added to your project using 
Design=>Templates=>Utilities=>Add=>All all to project.

The templates are run along the strings and the total volumes are reported. Volumes for each 
strings are given in the report file. An example follows.
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If a tin is created from these strings then volumes by depth can be determined using Design=>Vol-
umes=>Exact=>Tin to tin

Usage
Access this panel from the menu selection 

Design => Drainage => Reports => Excavation Quantities

The fields and buttons used in this panel have the following functions.

 ----------------------------- BEGIN APPLY TEMPLATE REPORT ------------------------------

  apply template to string report - 

    string         E
    tin            design
    separation         10.000
    left template  375
    right template 375
    cut volumes and areas are negative
    fill volumes and areas are positive

 chainage- ------sectional  information------  ------intermediate  information----    ---------accumulative  information-------
           ---------- ---cut area --fill area ------------ ----cut vol ---fill vol    -cut volume-- -fill volume- ---balance---

     0.000                 -1.434       0.000                                                 0.000         0.000         0.000
                                                                -0.771       0.000
     0.550                 -1.367       0.000                                               -0.771          0.000        -0.771
                                                               -14.222       0.000
    10.000                 -1.642       0.000                                              -14.992          0.000       -14.992
                                                               -15.293       0.000
    20.000                 -1.416       0.000                                              -30.286          0.000       -30.286
                                                                -1.845       0.000
    21.313                 -1.393       0.000                                              -32.130          0.000       -32.130
                                                                -0.794       0.000
    21.863                 -1.493       0.000                                              -32.924          0.000       -32.924

 total cut                         -32.924
 total fill                          0.000
 balance                           -32.924
 ie excess of cut over fill         32.924

 ----------------------------- END APPLY TEMPLATE REPORT ------------------------------
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Field Description Type Defaults Pop-Up

Drainage model input box

Model to contain all of the pit and pipe network to be worked on.

Strings model model box

Strings generated from the templates will be stored in this model

Sections model model box

Sections generated from the templates will be stored in this model

Report name input box

cut and fill volumes will ne sent to this report

Ground Surface Tin tin box

tins from which the volumes will be calculated

Separation real box

distance between the sections

Sections colour colour box

Sections generated from the templates will be assigned this colour (strings colours are defined in the 
templates)

Clean section/strings model tick box

Delete the strings in these models before processing.

Stop section at edge of pit tick box

Template are run from pit centre to centre if this is not selected. The templates stop at the edge of the pit 
if selected. This is often selected with the following option Use obvert templates.

Use obvert templates tick box

Templates must be named with the prefix “obvert”. i.e. obvert 300. The template is still run along the 
invert of the pipe but the user now has a section “set” of templates that can be used to create a tin on 
top of the pipe as well as below.
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12.0 Network Quantities Report
This panel is accessed from the menu selection 

Design => Drainage Sewer => Reports=> Network Quantities

Key points

1. Items are counted/totalled by depth and optionally type.

1. The routine will not "double count" items even if the ranges overlap. 

2. Types are case sensitive, types with spaces in the name must be enclosed in quotes and the wild 
card * may be used.

3. Use vertically offset tins and "banded" depth ranges to get quantities under roads, foot paths etc. 
This is discussed later in detail.

4. Erase count file fields if the items are not to be counted.

The fields and buttons used in this panel have the following functions.

Field Description Type Defaults Pop-Up

Data String Source Choice

usually the entire model is selected but view is also available for combining models
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Pipe size filter Choice diameter or pipe size attribute

The second item in a count line is used to filter by diameter (in meters/ft) or the pipe size attribute. The 
diameter can only be used when no box culverts or trapazoidal channels are used. The pipe size 
attribute is the label genrally used in the plan plots. This is the pipe size in mm/inches (375), for box 
culverts width x height (750x375) and for trapazoidal channels TopwidthBottomwidthxHeight 
(T5000B1000x500). 

Tin tin box

This tin will be used for the pipe and pit depths.

MH config file file box

This file specifies the types and depth ranges for the pits. Details of this file are contained below.

Pipe config file file box

This file specifies the types and depth ranges for the pipes. Details of this file are contained below.

HC config file file box

This file specifies the types and depth ranges for the house connections. Details of this file are con-
tained below.

HC pit config file file box

This file specifies the types and depth ranges for the HC pits. Details of this file are contained below.

HC jump ups file file box

This file specifies the types and depth ranges for the house connections jump ups. Details of this file are 
contained below.

Report file file box

a sample report file is given below.

Report unused ranges tick box

the depth ranges for the pit/pipe/house connections are defined in the *.4d files. Selecting this option 
will cause the depth ranges in the file to be printed even if there are no pit/pipe/house connections in 
these depth ranges (zero quantity values will be shown).

Report types tick box

Selecting this option will cause the pit/pipe/house connection types used in the model types to be listed 
(even if quantities are not requested in the *.4d files). Since this is a complete of the type used in the 
model, the list informs the user what types have not been included in the quantity calculation.

Count button

executes the option.

Finish button

removes the dialogue from the screen
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The *.4d files listed above are contained in the 12d library directory. Each line is the file performs a 
count (count lines). No items are counted twice. Therefore, if an item is counted its type and then a 
count line is found the wild card is used for the type, the type already counted will not be included in 
the count.

The format for a count line is three or four values (space delimited) per line. Size is optional.

<type (from drainage.4d)>  <size> <starting depth>   <ending depth>

Notes:
All types with spaces in the name must be enclosed in quotes The wild card * may be used.

The size is optional and if omitted the all sizes will be counted in this group (do not use the * for a 
wild card). 

The starting depth and ending depth are required for all count lines.

Quantities Under Roads and Footpaths
By creating super tins with vertically offset sections, quantities under roads, footpaths etc. can be 
determined. for example.

Offset your road design tin up by 1000m (Tins->Utility->Translate/Copy) and then use the depth 
range 1000-1999 for pipes under roads.

Create a tin from the footpaths only, null by angle length with a small length to remove the road and 
then offset it vertically by 2000m. the depth range 2000-2999 is not the quantities under the footpath.

Sample count lines
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// sum concrete cover manholes is various ranges

"CONC COVER" 0.0 1.6
"CONC COVER" 1.5 3.0
"CONC COVER" 3.0 999.9  // this is expected to be zero
"CONC COVER" -999.0 0.0 // trap errors

// any that are not Concrete cover will be counted here

* 0.0 1.6
* 1.6 3.0
* 3.0 999.9

Sample count lines for pipes follow. 

Manhole Quantities
====================================

CONC COVER          0.00    1.60    13      16.506
CONC COVER          1.60    3.00     1       1.510
CONC COVER          3.00   999.9     0       0.000
CONC COVER        -999.0     0.0     0       0.000

*                     0.00  1.60     0       0.000
*                     1.60  3.00     0       0.000
*                     3.00 999.9     0       0.000

  total length = 18.016

  Types Used
  ----------

  CONC COVER

  Diameters Used
  ----------

  1.100

 

Since the Report unused 
ranges tick box was selected, 
these lines were printed even 
though there were no pits in 
the data ranges.

This data results from select-
ing the Report types tick 
box.
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// sum class 2 pipes by diameter and for various ranges

// count 375

2 0.375 0.0 2.0
2 0.375 2.0 5.0
2 0.375 5.0 999.

// count 450

2 0.450 0.0 2.0
2 0.450 2.0 5.0
2 0.450 5.0 999.

// count 525

2 0.525 0.0 2.0
2 0.525 2.0 5.0
2 0.525 5.0 999.

// count pipe sizes that were missed

2 * 0.0 2.0
2 * 2.0 5.0
2 * 5.0 999.

// count all other missed pipes

* 0.0 999.



Revised October 2010 12d Stormwater Course - Part 2 Notes: Page 53 of 88

12d Solutions Pty Ltd

COURSE NOTES

STORMWATER DESIGN - Part 2

13.0 Exporting to Drainage Design Software Packages
12d contains most of the data required for your drainage design packages. However, each pack-
ages has specific design variables that 12d does not have access too. The design process is 
intended to export your data from 12d to the design package, design the drainage system and then 
read the results back into 12d for your long sections. 

If pits/pipes are to be added/deleted from your network during the design process you are safest to 
add/delete the pit/pipe to 12d and to your design package separately.

Not recommended and as a poor alternative, you have the option of reading the results back into 
12d, adding/deleting the pits/pipes and then exporting the data to a new drainage project in your 
drainage design software. As 12d does not have access to all of the data in the design packages 
this method is not recommended!

Some of the drainage design programs offer a third option that allows you to import data “on top 
of” an existing project thereby merging and over writing the existing data. Be sure to contact the 
drainage software supplier to obtain exact details of how the merging process is performed.

The interface is run by selecting Import/Export from the Drainage Network Editor

Design->Drainage-Sewer->Network Editor
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Export pipe diameters and inverts is generally select for existing systems only. If your design pro-
gram will set invert levels and pipe sizes then turn this tick box off for new systems.Some design 
programs will require initial inverts and pipe sizes. In this case this box should be selected on the 
first export.

Export default catchment/pit parameters is generally selected for the first export. For subsequent 
exports turn this selection off and then only the catchment areas (if the model is supplied above) will 
be exported.

The Drainage model is the model 
currently being edited.

The I/O format selects which exter-
nal program the 12d is interfacing 
with. Some programs use the win-
dows clipboard and others use files. 
If the clipboard is used the data will 
also be written to a file by 12d in 
case you need to take the data to 
another computer.

Export enables the export fields 
below and exports when Run is 
selected.

The Export options have slightly 
different effects depending on the I/
O format (program) selected above. 
Therefore they will be discussed 
later with the various formats.
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14.0 Drainage Data Input and Output to Spreadsheets
Spreadsheets are an effective method to manage the numerous variables urban drainage designers 
create in the modelling process. Spreadsheet data can be transferred to and from 12d in tab delim-
ited files and stored within 12d as “user definable attributes”. These attributes are linked to the pit 
and pipes within a network. Drainage long section plots can display the pipe attributes in the 
“arrows” data area and pit attributes in the bubbles area. Drainage plan drawing can also show 
these pit and pipe attributes.

Drainage strings will be created if they do not exist in the model but pits cannot be added to exist-
ing strings.

See also

12d to spreadsheet transfers

Spreadsheet to 12d update and create

Spreadsheet options

14.1 12d to spreadsheet transfers
This interface is accessed the Import/Export button on the Drainage Network Editor.
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14.1.1 Options

Select Spreadsheet clipboard

These options are not used for 
spreadsheet export.

Usually leave this off! Select 
to export the junction pit at the 
end of all drainage lines (very 
rarely needed).

You may also select to limit the 
output if desired. If you like 
using spreadsheets for data 
entry, the PCdrain data and 
ILSAX data formats are useful 
for adding data for the first time 
for either program.

Select Run to place the data on 
the clipboard.
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The Spreadsheet Options section allows the user to define the amount of data exported.

All Data: All of the 12d drainage string data and the user defined attributes will be exported to the 
clipboard in a tab delimited format. The 12d data names and the user defined attribute names will 
appear at the top of the spreadsheets columns.

ILSAX: For the ILSAX program, the spreadsheet column headings will change depending on the 
pipe and catchment indicators (P2 card) and the inlet type (P3 card). Therefore, use the ILSAX 
pipe editor macro to set up one pit/catchment for the type of data you wish to enter. Now when 
you export the pipe network data the column headings will include the names of the relevant 
parameters.

User defined below: The Customised list file name is used to define the drainage values, their 
order and format you desire.

The customised list file is a text file where each line contains a drainage variable or a spreadsheet 
IO command (blank lines are ignored unless preceded by the header command). The spreadsheet 
IO commands are all lower case and listed below:

header to define a line of text to be exported
blank to leave a blank column in the output
pit data the following attributes are for the pit.
downstream pit data the following attributes are for the downstream pit.
upstream pit data the following attributes are for the upstream pit(s).
pipe data the following attributes are for the pit’s outlet pipe
downstream pipe data the following attributes are for the downstream pipe(s)
upstream pipe data the following attributes are for the upstream pipe(s)
variable name a 12d drainage variable names
factor the following variable is multiplied by this factor
decimals the following variable will export with these decimal places

Export all junction pits 
when selected will repeat 
the data for the junction 
pit at the end of each 
branch line.

Preset Output this 
choice box offers the fol-
lowing choices:
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The simplest way to create your own customised tab delimited file is to set the Preset Output field 
to All data and leave the customised list file name field blank. Selecting Set, Finish and then Copy 
from the main dialogue. The data will be placed on the clipboard and a customised list file, named 
output_list.txt will be created containing the names of all of the drainage variables in the 12d 
model. Use a text editor to add/or delete the variable names, change their order and/or add spread-
sheet IO commands. Save the file with a new name! The output_list.txt file is overwitten on every 
export.

A listing of a customised list file follows. Note the words in the header file have a “tab” between 
them so that they will be spaces across the spreadsheet columns.

After creating your customised list file, select Options again and change the Preset Output field to 
User Defined below and enter the new customised list file name that you saved above. Select Set 
then Finish and finally Copy to put the formatted data onto the clipboard.

The data can be pasted into a spreadsheet program for checking or additional formatting.

CUSTOM FORMATED DATA MIGHT NOT BE PASTED BACK INTO 12d!

The data must be in the “12d drainage spreadsheet” format to be read into 12d.

Caution with pit names in the form 1-1 or 1/1. Some spreadsheets will interpret these values as dates. 
If you use these formats for your pit names you will have to paste command them in once, format the 
columns that contain the pits names as text data and then paste the information in again.

One final word on using the copy/paste commands in the Microsoft Excel program. The Paste Spe-
cial command using the “Skip Blanks” option will allow you to copy a large block of 12d data (with 
blanks in it) on top your data so that your data is preserved where it coincides with the blanks. To use 
this option paste the data into a blank spreadsheet and then select copy again. The Paste special 
option with “Skip Blanks” will now be available.

header

Pipe Details

header
Name Length   U/S IL   D/S IL   Slope(%)   Class   Dia I.D.   Rough   Pipe Is   No. Pipes

pit data
*pit name

pipe data
*length
low ch invert
high ch invert

factor
100
*grade

pipe type

factor
1000
diameter
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14.1.2 Spreadsheet to 12d transfers
This item is accessed from the Import/Export button on the Drainage Network Editor.

The following panel will appear.

Tab delimited, “12d drainage spreadsheet” format or “from to” format data must be on the clip-
board in order to update a 12d drainage model or create a new model. These format are described 
below.

14.1.3 Updating an Existing Model
The data usually is generated by 12d using the Export option, pasted into a spreadsheet and then 
copied back to the clipboard so that 12d can be updated. 

When 12d exports the drainage model to a spreadsheet it includes a column for the unique string 

Select the Spreadsheet clipboard 
format.

Select Import

This is ignored on spreadsheet 
imports.

Select Run to update the drainage 
model.
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identifier and a unique pit identifier (unique to the drainage model not the 12d project). The names of 
the strings and pits may be changed via the spreadsheet if these columns are present at import time.

If the pit id column is not present, 12d will search the drainage model for a matching pit name. When 
the pit is a junction between drainage lines, only the trunk line will be the data updated.

14.1.4 Creating a New Model
It is possible to create a new string or an entire drainage network using this format. However, pits 
cannot be added to an existing string. The entire drainage string must be created at once. Two for-
mats are available, the “from-to pit” format and the “12d drainage spreadsheet” format. 

At present the network editor must select a drainage string to become active. Therefore, if you are 
not adding strings to a network, you will have to great a drainage network with one “dummy” pit. 
Select this one “dummy” pit to activate the editor. After importing the data and the new drainage 
lines are created the “dummy” pit may be deleted.

12d drainage spreadsheet Format
The top left cell in the clipboard data must be the text “12d” to specify this format. The mini-
mum amount of data required to create a new string is the string name, pit name, x and y coor-
dinates. You can add as much additional data as you have available. This would include pipe 
diameters inverts etc. The pits must be listed from upstream to downstream order. If the string 
is to join a trunk line, the junction pit must be included for both the tributary and the trunk line.

An example file exists called new_network.txt is supplied in the library. Open this file in a 
spreadsheet or a text editor and copy it to the clipboard. Set the I/O Action to Import and 
select Run. The new drainage lines will exist in the model currently being edited.

From-to Pit Format
The top left cell in the clipboard data must be the text “from to” to specify this format. The 
minimum amount of data required to create a new string is the upstream pit name "*pit name), 
the downstream pit name (*ds pit name) and the x(x location) and y(y location) coordinates of 
the upstream pit. If the string is to join a trunk line, the junction pit must be included for both 
the tributary and the trunk line. 

An optional column for the pit cover elev (cover elev) may be specified. Once the network has 
been created additional pipe and pit data may be added using the “12d drainage spreadsheet” 
format described above.

An example file exists called new_from_to_network.txt is supplied in the library. It is shown 
below. Open this file in a spreadsheet or a text editor and copy it to the clipboard. Enter a new 
model name in the Drainage model field and select paste. The new drainage model will now 
exist. 
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14.2 “12d drainage spreadsheet” Format
Each column of data is used for a 12d drainage variable or a user defined attribute. Each row rep-
resents a pit and the downstream pipe (controlled by the direction of flow variable) within the 
drainage network. A sample is shown below.
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Duplicate Definitions
Strings Variables such as “direction” are may be defined for numerous pits on the same string. 
Searching in a top down direction through the file, the last definition found for the string will be set.

Invert levels may be set via pipe data or pit data or combined. It is recommended that the user only 
use one method and not combine them. Both are exported so delete the ones you are not going to use. 
The variables are processed from left to right, so if duplicate definitions of an invert level or found 
the right most data will be set.

The format definition
1. Row1, column 1 must contain either “12d”, or “from to”. Therefore, the first column must be a 

12d drainage variable (cannot be a user defined attribute).

2. Row 1. The text <pit> at the top of the column indicates the column contains a user defined pit 
attribute and similarly <pipe> indicates a user defined pipe attribute.

3. Row 2. This row contains the names of the 12d drainage variable names and the pit/pipe 
attributes. All names are case sensitive so be careful where you use capital letters. A list of 12d 
drainage variables is found below.

Names beginning with an asterix (*) will not be processed (except pit/string names when unique 
identifiers are present in the data). 12d drainage variables names beginning with an asterix indi-
cate that this data was calculated at export time and cannot be read back into 12d (for example, 
pipe length, pipe grade and deflection angle). 
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Prefixing an user defined attribute name with “DELETE ” (no quotes, note the space after the 
DELETE) will cause the attribute to be deleted from all pits/pipes within the model.

4. Row 3. The text in this row define the type of attribute to be stored within 12d. The only valid 
choices are;

integer
real
text

If you want to change an attribute type you must delete the attribute and create it again. If you 
simply change the attribute type in the third row then that attribute will not be updated.

5. Blank lines may be inserted as desired.

6. You are not required to fill in all of the cells in the spreadsheets. Blank cells are ignored (you 
must use a space to remove all data from text attributes (the space will not be stored).

7. Pipe names are included in the data so that they can be changed but they are not used to iden-
tify the pipe. Pipe data will always be assigned to the pipe following the pit in the direction of 
ascending chainage. If flow directions is ascending then the pipe data will be for the down-
stream pipe. If the flow direction is descending then the pipe data will apply to the upstream 
pipe.

14.3 12d Drainage Variable Names
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15.0 Detailed Drainage Plan Drawing - Creating MH Symbols
There are many methods to create the drainage symbols and one is presented here. The pit symbol is 
drawn so that the symbol “sits on” the road string that it aligns with (the road string is the y refer-
ence). For drawing lintels and grates, assume the road is downhill to the right. See diagram below.

Two symbols are required, one for the left side of the road and one for the right side (referred to as 
the mirror symbol in the plan ppf). 12d checks the downhill direction of the road strings when using 
these symbols to determine which is the left and right side of the road.

Either draw your own symbol or import the symbols using File IO->Data Input->4ds/12da data 
and selecting the file inlet symbols.12da

To create the symbol in 12d draw the left pit symbol in a model by itself. The pit should “sit on” the 
zero “y” grid line. A 900 wide by 600 long inlet with a 1.2m lintel is shown above.

From the main menu, select

Project->Tree

Expand Project then expand Symbols and finally select Create Symbol.

Road string (dark green) that 
manhole symbol (black) “sits 
on”.

symbol insertion point is the 
manhole centre or setout point 
(x = 0, y = 0.95 in this case).

Symbol is centred on the x=0 and 
“sit on” the y = 0.

0.95
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Write will add the new symbols to the symbols.4d file so that they will be available to other 
projects.

Leave this panel open as we will need it after we create the mirror image of the pit.

To create the mirror image of the symbol about the x axis use the CAD mirror about X axis com-
mand. 12d will require you do this one string at a time. Version 7 does not mirror into a new 
model so you will want to duplicate the pit symbol model first using Utilities->A-G->Duplicate.

Now repeat the process of creating the right side mirrored symbol. Note that the location of the pit 

Enter the Symbol Name. Usually the name 
includes the size.

Select the Group the symbol is to appear in 
the symbol drop down menu and select 
World as the symbol type.

Enter the x,y location of the manhole cen-
tre in your drawing (0 is different then 

Select the model that contains the manhole 
drawing.

Process will create the symbol in the 
project.

Change the symbol name, origin y and 
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centre is now negative and add the suffix mirrored to the symbol name.

Do not forget to select Write again to save the symbols to the symbols.4d file.

These symbols can now be used in the Maintenance hole tab of the Drainage Plan Plot ppf editor. If 
your version of 12d supports, native-size symbol, in the ppf editor then use this mode. If not, select 
scalable symbol and enter the size equal to the full width of the symbol (height if it is greater).
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16.0 User Defined Attributes
These drainage attributes are automatically created by 12d when required but you are free to 
change them or add more as desired. The attributes may be exported to a spreadsheet and edited 
and then imported back into 12d. To edit/add the user defined attributes within 12d select either

Strings=>Properties=>Attributes or

Strings=>User=>Attribute Editor. This second editor is described below.

.

They may not be defined for the pit you are editing. Not found will be displayed in the Data field 
if the pit does not have that attribute defined.

To change the value for the attribute 
enter the new value in the data field. If 
the attribute does not exist, deleting the 
not found text and adding data will cre-
ate it. The message on the right will be 
displayed whenever you are creating a 
new attribute.

First Select Pick to select the string that 
contains the user attributes (the drainage 
string). The strings will be highlighted in 
white when they are selected.

All catchment data is store with the pits in 
drainage strings. To access the pit attributes, 
select the drop down icon and then select 
pit. A circle will be drawn around the pit 
selected. Next and Prev will now move you 
from pit to pit.

Select the drop down icon and then select 
the Attribute Name from the list of existing 
user defined attributes. These attributes 
include all of the attributes in the model that 
the string exists in. 
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16.1 Drainage Pit attributes
Pit attributes are created and/or updated when the user selects Set Pit Details.
pit length real 0 mhsize (first value) from drainage.4d file
pit width real 0 mhsize (second value) from drainage.4d file
pit group text mhgroup from drainage.4d file
cover rl real 446.685248
grate level real 446.685248
setout z real 446.685248
setout x real 299643.648
setout y real 6563620.716
setout distance real 0
pit name text 1-3
pit type text SA2
pit diameter real 1.1
pit chainage real 118.61441375
pit centre x real 299643.648
pit centre y real 6563620.716
pit centre fs level real 446.685248
pit centre ns levelreal 446.685248
ds invert real 445.307 upstream invert level of exit pipe
ds pit text 1-2 ds pit along the pipe network
sump level real 445.307
pit depth real 1.378

Extra Atttributes from Pit - Main Tab 
cover rl mode integer 1
design freeboard real 0.4
direct flow real 0.02
grate rl mode integer 1
inlet type integer 0
ku real 0.2
ku config integer 1
ku method integer 1
kw real 0.22
sump offset real -0.2

Extra Attributes from Pit-Setout Tab
road chainage real 10
road chainage modeinteger 2
road name text My Road
road offset real 12
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setout adjustmentreal -1
setout adjustment zreal 0.045
setout xy mode integer 0
setout z mode integer 8

Extra Attributes from Pit-Bypass Tab
bypass pit text 12.4P
choke major real 0.8
choke minor real 0.7
choke pog major real 0.8
choke pog minor real 0.7
inlet capacity curvetext Sutherland - 3% crossfall
manual pit grade integer 1
manual pit xfall integer 1
pit grade real 1
pit xfall real 3

Extra Attributes from Pit-Notes Tab
reamrks text constructed by others

Setout string selected
design model id uid 52
design string id uid 61
pit symbol angle real 81.48609728
pit symbol bearingreal 8.51390272
pit symbol bearing dmstext 8°30'50"
pit grade real 4.00 if bypass pit present

Centre line string selected (with bypass and setout)
pit xfall real 3.00 if bypass pit present
centre model id uid 52
centre string id uid 92
mirror pit integer 1 mirror symbol required for plotting

Bypass Pit entered
bypass pit text 1-2 next pit along bypass string
inlet type integer 1
choke major real 0.8 ongrade or sag choke (see sag setting)
choke minor real 1 ongrade or sag choke (see sag setting)
inlet capacity curvetext SA2 3% Grade

calculate if pit grade and/or pit xfall present
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(pit type - inlet cap curves determines which are 
required)

pit grade real 4.00 if setout string selected
pit xfall real 3.00 if centre line string selected

The following require the bypass string (manual entry of bypass pit is not enough).
bypass distance real 33.995 distance to bypass pit
gutter length real 99.79 dist. up the bypass string to next pit or end of string 

(longest bypass route if multiple)
gutter grade real 2.70 (us pit fs levels - ds pit fs levels) / gutter length)

Catchment Tab data
area real 0.1
percent imperviousreal 60

Pervious Area only
c major pervious real 0.9
c minor pervious real 0.8

For both pervious and impervious (change pervious to impervious)
catchment grade perviousreal1
catchment length perviousreal900
catchment roughness perviousreal0.1
tc major perviousreal 5
tc method pervioustext Kinematic Wave
tc method pervioustext Direct
tc minor perviousreal 5

Export Pit Atttributes (calculated when Export selected on Import/Export button))

inlet type integer updated to include 5 for headwalls 
ds pit string id uid drainage string id for the ds pit
ds pit index integer index number of the ds pit (counter along the string)
area impervious real %impervious * area for set 1
area pervious real %pervious * area for set 1
area impervious2 real %impervious * area for set 2
area pervious2 real %pervious * area for set 2
area impervious3 real %impervious * area for set 3
area pervious3 real %pervious * area for set 3
pcdrain pit type type pit type with the pcdrain suffix (S + pond depth)
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Export Pipe Atttributes (calculated when Export selected on Import/Export button))

locked diameter real pipe diameter (exists only if pipe locked)
locked invert us real pipe us invert (exists only if us invert locked)
locked invert ds real pipe ds invert (exists only if ds invert locked)
windes diameter real if pipe type is WINDES, value is neg diameter
roughness n real if “roughness type” is Manning then roughness value

otherwise it is 0
roughness k real if “roughness type” is Colebrook then roughness value

otherwise it is 0

16.2 Drainage Pipe attributes
Set Pit Details
invert us real 28.47
invert ds real 28.422
diameter real 0.225
pipe size text 225
pipe type text 2
roughness text text n=0.010
calculated pipe lengthreal 9.58175349
calculated pipe gradereal 0.50095215
calculated pipe grade 1 inreal199.6198644
calculated us deflectionreal 71.75414547
calculated ds deflectionreal -36.3032794
pipe name text 12.5P to 12.4P
minimum cover real 1.04113728
calculated drop real 0.03

Additional Pipe Attributes created via Pipe Tab setting
design alignment modeinteger0
design cover real 0.4
design cover modeinteger 0
design drop real 0.03
design grade real 0.1
design size mode integer 0
diameter real 0.225
direct pipe flow real 0.01
lock ds il integer 1
lock size integer 1
lock us il integer 1
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max height real 0.6
min height real 0.3
remarks text extra pipe notes
roughness real 0.012
roughness type text Manning
width real 0.225
width top real 6
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17.0 Detailed Drainage Plan Drawing
12d drainage has the capability to create detailed drainage plan drawings with the following features:

screate symbols at the inlets and the type of symbol is controlled by the inlet type (given when you cre-
ate the inlet).

screate text labels for inlet types and user defined pit attributes

sdraw lines with line styles and colours to represent pipe sizes

screate text labels for pipe diameters, inverts and user defined pipe attributes

screate text labels for house connection types, invert levels and chainages

sindicate direction of flow on pipes.

An example is shown below

Usage
This option is accessed from the menu selection 

Design => Drainage-Sewer => Plots => Plan Annotations
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The fields and buttons used in this panel have the following functions.

Field Description Type Defaults Pop-Up

Plot parameter file file box

Optional - no dpf is required. The default settings will create a schematic drainage drawing. A custom dpf 
may be selected if desired.

Load design details from model box

data source for drainage strings to be labelled

Save plot annotations to modelmodel box
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labels to be created are stored here, Undo will remove the labels created

Clean plot model before handchoice box

smart clean will update text that has been moved and clean the rest. Full clean will all text from the 
plan annotations model.

Set colour as string name tick box

when selected the string colour will be used for the string name (to be used for DWG/DXF export using 
map files)

Plot button

Creates the labels in the model specified

Find button

used to locate plot parameter input boxes using Version 5 plot parameter names

IMPORTANT! to turn off any data change the text height to zero.

Select Maintenance holes from the tree to set the symbols to be used for the various pit types.

Select the MH type as desired and use scalable symbol and setout point. For the symbols enter 
the names that you used when you created the symbols.
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Plotting a symbol at 
the pit setout point is 
a good confirmation 
of the data printed in 
the setout reports. 
The settings to create 
this symbol are 
shown on the left.
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18.0 Drainage Long Section Plotting - Hatching Under Roads
The drainage long section plotting has been discussed in the Intro Drainage Course. Here we will 
discuss the technique for hatching under roads and/or footpaths. 

The following steps are required.

1. Run the Excavation volumes routine using the obvert templates to create sections and strings 
for a tin on top of the pipe (obvert tin). Select Stop section at end of manhole to prevent the 
pits from being hatched

2. Create the obvert tin from the strings and sections then and null by angle length with a small 
length value so that the tin is nulled near the pits.

3. Create a design tin that extends to the limit of the roads.

4. Use the hatching section of the drainage long section plot to select the hatching style.

18.1 Creating the Obvert strings.
Run the Drainage Plan Plot by selecting Plot from the Drainage Network Editor. 

Select the drainage_design ppf file from 
the library.

Select the folder icon then Open the ppf.
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Confirm that the Pipe string level mode is set to pipe obverts and that all symbols with elevations 
are not used. This include:

s MH setout points,

s Flow arrows,

s pit symbols

Now plot the drawing and we will use the pipe strings at the obvert level to create a tin.
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18.2 Create and Null the Obvert tin

To create the obvert tin select.

Tins->Create->Triangulate Data

Enter a New tin name as desired.

Select the Nulling tab

Enter a Length that is less than the pit 
diameter and greater than the largest pipe.

Select Triangulate

Select the Data tab.

Select the plot model created above.
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The tin will now only exist on top of the pipe and it is ready to use for hatching.

18.3 Create a Roads Only Tin
The design tin is already nulled to remove the long triangles. If the footpaths were to be excluded 
from the tin then they should be removed from the road design strings. You could run a template that 
did not include the footpath and has a Final Maximum slope width of zero or just copy the desired 
road strings to one model and remove unwanted strings. We will use the later techniques.

Add all of the road string and kerb return models onto one view and then select

Utilities->A-G->Change

View select the view that contains all of the road 
strings

Copy to model type the name of a model for all of 
the road strings.

Select Change copy the strings.
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Now to create the tin select Tins->Create->Triangulate data

Select the Filter icon at the end of 
the selection strip. Now select the 
Model tab and select the Name of 
the model that holds all of your road 
and kerb strings road strings only 
(tab not shown here).

Select the String Info tab and enter 
the name of the strings that you 
want to remove from the road only 
model. In this case it is path.

Select Filter Select to select these 
strings.

Select the second Target button 
Move to model and select the 
model trash and then select 
Change.

Repeat this for string names int.

We are now ready to triangulate the 
road only tin.
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Model - Select the model containing 
the road only strings.

Enter a function name (optional) and New 
tin name and then select the Data tab.

Length - Select a length just greater than 
the width of half the road so that the tin 
will not be nulled from the end of the 
roads.

Select Triangulate..
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18.4 Use the Hatching Feature in Drainage Longsections
We are now ready to create the drainage longsection plots. Set up a section view with the a string 
in the drainage model profiled, the vertical exaggeration set, the desired tins displayed and the 
service models added. From the main menu select,

Design->Drainage-Sewer->Plots->Longsections

From the Plot parameter file field select a drainage longsection ppf from the library and then 
select Read.

In the View to load details from field select the section view you have setup for the drainage long 
section.

Now select Hatching cut/fill
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Now select the + beside the Hatching cut/fill and then select fill.

Define set is set to 1.

Original tin is set to 
the obvert tin.

New tin is set to the 
road only tin.
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Use set # is entered as 1. Fill separation, hatch angle, colour and linestyle selected as desired. 
Draw sides of tin, Draw original tin and Draw new tin are not required unless you want these 
extra line in the drawing.

Select Plot and add the plot model drainage LS plot1 onto a PLAN view to preview the drawing.
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The hatch-
ing is shown 
to the left at 
a 2mm spac-
ing with the 
tins and 
sides not 
drawn.
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19.0 Flooded Width Analysis and HEC RAS
There are 2 flooded width methods in the drainage module. The first can be used with any of the 
external drainage packages and the second is part of the 12d storm analysis. The first is found on 
the main menu 

Design->Drainage-Sewer->Calc flooded widths

The name of the overland flow string becomes the name of the HECRAS project.
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